
Description
This tutorial illustrates a very common use of EDSMAC, that is, to perform a
time-distance study to evaluate accident avoidability. We’ll be able to watch
as the vehicles approach each other and determine the first point of
visibility between vehicles.

This tutorial is a continuation of the EDCRASH Tutorial, wherein the initial
vehicle velocities were estimated. You may wish to review that tutorial before
continuing.

Like all EDSMAC events, the procedure involves the following basic steps:

� Create the vehicle(s)

� Create the environment

� Execute the EDSMAC event

� Review the EDSMAC output reports

This basic procedure is described in detail in this tutorial.
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Getting Started
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As in other tutorials, before we get started with our current tutorial, let’s set the
user options so we’re all starting on the same page.
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To set the initial user options, choose the following from the Options Menu:

� ON: Show Key Results

� OFF: Show Axes

� OFF: Show Velocity Vectors

� ON: Show Skidmarks

� OFF: Show Targets

� ON: AutoPosition

� Units equals S.I.
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� Render Options:

� Show Vehicles as Actual

� Phong Render Method

� Complexity equals Object

� Render Quality equals 5

� Texture Quality equals 1

� Anti-aliasing equals 1

The remaining options will automatically initialize to their default conditions.
We’re now ready to proceed with the tutorial.
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Creating the Vehicles
Let’s add the vehicles to our case. The first vehicle is a white, 1996 Ford Escort
2-Door Hatchback; the second vehicle is a dark red 1995 Nissan Sentra 4-door
Sedan. Let’s add the first vehicle:

� If the Vehicle Editor is not the current editor, choose Vehicle
Mode. The Vehicle Editor is displayed.

� Click Add New Object. The Vehicle Information dialog is
displayed. The Vehicle Information dialog allows the user to
select the basic vehicle attributes according to Type, Make,
Model, Year and Body Style.
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� Using the option buttons, click each button to choose the
following vehicle from the database:

� Type = Passenger Car

� Make = Ford

� Model = Escort

� Year = 1991-1996

� Body Style = 2-Door Hatchback

� Driver Location = Right

� Click OK to add Ford Escort 2-Dr Hatchback to the Active
Vehicles list.

The Ford Escort is added to the case. Next, let’s add the Nissan Sentra.

� Click Add New Object. The Vehicle Information dialog is

displayed.

� Using the option buttons, click each button to choose the

following vehicle from the database:

� Type = Passenger Car

� Make = Nissan

� Model = Sentra

� Year = 1995-1999

� Body Style = 4-Door

� Driver Location = Right

� Click OK to add Nissan Sentra 4-Dr to the Active Vehicles list.

We now have the vehicles required for our study, as shown in Figure 5-1.
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Editing the Vehicles

Next, we’ll edit the vehicles to change their color and weight. In addition, we’ll
change the stiffness of the Nissan Sentra, using values derived from our initial
reconstruction analysis.

Start by changing the color of the Ford Escort:

� Select the Ford Escort 2-Dr Hatchback from the Active

Vehicles drop-down list, making it the current vehicle. The

Ford Escort is now displayed in the Vehicle Editor.

� Click on the CG and choose Color. The Vehicle Color dialog is

displayed (see Figure 5-2), showing the vehicle’s current color

(the small black square, or hot spot, in the color wheel) and

intensity (the arrow in the intensity slider). Click on the hot spot

and drag it to the center of the circle. To lighten the vehicle, click

on the intensity slider and drag it to the far right end.
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� When the color is to your liking, press the Close button to

apply the new vehicle color.
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Next, let’s change the Escort’s weight. Perform the following steps:

� Click on the CG and choose Inertias. The Inertias dialog is

displayed (see Figure 5-3), and we’re ready to change the

vehicle’s weight.

� In the Total Weight text field, replace the existing weight,

10283Newtons, with the measured value,11037Newtons.
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� Press OK to accept the weight value.

The Ford Escort is now ready for use in our tutorial. Using the viewer thumb
wheels and/or manipulators, pan, zoom and look at the vehicle.
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Now, let’s change the color, weight and stiffness of the Nissan Sentra:

� Click on Nissan Sentra 4-Dr in the Active Vehicles list,

making it the current vehicle. The Nissan Sentra is now

displayed in the Vehicle Editor.

� Click on the CG and choose Color. The Vehicle Color dialog is

displayed. The vehicle’s color is fine, but we need to darken it.

To darken the vehicle, click on the intensity slider and drag it to

the middle of the range.
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� When the color is to your liking, press the OK button to apply

the new vehicle color.

Next, let’s change the Nissan’s weight:

� Click on the CG and choose Inertias. The Inertias dialog is

displayed.

� In the Total Weight text field, replace the existing weight,

10858Newtons, with the measured value,11282 Newtons.
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� Press OK to accept the weight value.

Finally, let’s change the stiffness of the vehicle. From a previous
reconstruction analysis, the A and B stiffnesses were re-calculated in order
to balance the forces (the technique is described in references [20] and
[21]). Based on this analysis, a new K� stiffness was calculated.

� Click on the front side surface icon (red sphere). The CG to

Front dialog is displayed.

� Click Stiffness. The Stiffness Coefficients dialog for the front

surface is displayed, as shown in Figure 5-4 on the following

page.
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To edit the current K� stiffness value:

� In the K� Stiffness field, replace the current value, 58.3, with

the calculated value, 72.4 N/cm
�
.

� Click OK to update the stiffness.

� Click OK again to remove the CG to Front dialog.

The Nissan Sentra is now ready for use in our tutorial. Using the viewer
controls (thumb wheels and manipulators), view the vehicle.

Now, we have both vehicles ready for our study.
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Saving the Case
Now that we’ve created vehicles for our case, let’s save the case file.

� Click on the File menu and choose Save. The Save-as File

Selection dialog is displayed.
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� In the Case Title text field, enter EDSMAC Tutorial,

Visibility Study.
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� In the Filename text field, enter EDSMACTutorial.

� Click SAVE. The current case data are saved in the

hve2d/supportFiles/case subdirectory.

� ����� #	 ��� ��� ���� ���	����	��' �� 	 �����'

��������
�
 ��	�����!

� � "

��#	
� ��� ���� �����	��

T
U

T
O

R
IA

L



Creating the Environment
Now, let’s add the environment:

� Choose Environment Mode. The Environment Editor is

displayed.

� Click on Add New Object. The Environment Information

dialog is displayed.

� Using the Location Database combo box, choose Sydney,

NSW, Australia. The latitude (35.30.00S), longitude

(151.10.00E) and GMT, hours from the prime meridian (+10)

are displayed for the selected location.
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� Edit the name for the accident site, Blind

Intersection.

� Edit the date and time of the incident we are studying,

7-23-97 and 1330, respectively.

� Edit the angle from true north to the earth-fixed X axis in our

environment, -10 degrees.
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� To add the environment geometry file to our case, click on

Open. The Environment Geometry File Selection dialog is

displayed.

� Assure that the Files of Type option is set to HVE Geometry

Files (*.h3d). A list of environment geometry files using the

.h3d file format is displayed in a list box. Double-click on

EdcrashEdsmacTutorial_2D.h3d to choose the environment

file and remove the dialog.

� Press OK.

The selected environment is added to our case and displayed in the
Environment Viewer (see Figure 5-5). Use the viewer thumb wheels to view
the scene.
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Creating Events
As mentioned at the outset, this EDSMAC tutorial is an avoidability study in which
visibility plays a key role. With this in mind, we will start simulating the event well
before impact to illustrate the visibility between vehicles, as obstructed by the
building on the southwest corner of the intersection.

To create the event, perform the following steps:

� Choose Event Mode. The Event Editor is displayed.

� Click on Add New Object. The Event Information dialog is

displayed.

� Select Ford Escort 2-Dr Hatchback and Nissan Sentra 4-Dr

from the Active Vehicles list. The vehicles are added to the

Event Humans and Vehicles list.

� Select EDSMAC from the Calculation Method options list.

� Enter a name for the event, Visibility Study.
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� Press OK to display the event editor.
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Now, we’re ready to set up the event. This step involves placing the vehicles in
the environment and assigning driver controls:

� Select Ford Escort 2-Dr Hatchback from the Event Humans &

Vehicles list.

� Choose Set-up from the menu bar, select Position/Velocity.

The Escort is displayed in its initial position at the earth-fixed

origin.

� Click on the vehicle’s X-Y manipulator (see Figure 5-6), wait

for it to turn bright yellow (indicating it has been selected), and

drag it to its initial position, X=35m, Y=15m. Click the yaw

manipulator and rotate it to its heading angle, 180 degrees.
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� Click the Velocity Is Assigned checkbox. Enter the initial total

velocity, 40 km/h, followed by Apply (or simply press

<Enter>).

Next, let’s enter the driver controls:

� Choose Set-up from the menu bar, select Driver Controls. The

Driver controls dialog is displayed. The default driver control

table, Steering, is also displayed for editing.
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� Enter the values shown in Table 5-1 into the steer table:

Next, let’s assign the Brake Table for the Ford Escort:

� Click the Brake tab on the Driver Controls dialog. The Brake

dialog is displayed for the Ford Escort.
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Time
(sec)

Steer Angle at Steering Wheel
(degrees)

1.50 0.0

2.00 90.0
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Enter the Escort’s brake table using the % Available Friction (default) method:

� Enter the values shown in Table 5-2 into the table:

� Click OK to accept the Ford Escort’s steering and brake tables.

Event set-up for the Ford Escort is now complete. Let’s set up the Nissan
Sentra:

� Select the Nissan Sentra from the Event Humans and Vehicles

list.

� Choose Set-up from the menu bar, select Position/Velocity.

The Nissan is displayed at its initial position at the earth-fixed

origin.

� Click on the vehicle’s X-Y manipulator (see Figure 5-7), wait for
it to turn bright yellow (indicating it has been selected), and drag it
to its initial position, X=3.5 m, Y=39 m. Click the yaw
manipulator and rotate it to its heading angle, -90 degrees.
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� Click the Velocity is Assigned check box and enter the initial

velocity, 35 km/h, followed by <Enter>.

� ����� )������� �� ����� %���' �� B�����C! ����������
���  	�
� ���� ��� �� 	������
!

� � ��

������ �����	
� �#�
��

Time
(sec)

Percent Available Friction (%/100)

R/F L/F R/R L/R

2.25 0.00 0.00 0.00 0.00

2.35 1.00 1.00 1.00 1.00

2.70 1.00 1.00 1.00 1.00

2.80 1.00 1.00 0.01 0.01
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The Nissan’s initial position and velocity are now established. Let’s enter the
driver controls. In this case, there are no driver inputs, per se. However, after
impact the vehicle coasts to rest, so we need to enter rolling resistances:

� Choose Set-up from the menu bar, and select Driver Controls.
The Driver Controls dialog is displayed.

� Click the Brake tab. The Brake Table is displayed.

� Click on the Table Is option list and choose the Available
Friction option.

� Enter the rolling resistances after impact, as shown in Table

5-3, next page.

� Press OK to accept the table.

This event lasts more than 5 seconds. To prevent premature termination, let’s
increase the default maximum simulation time.

� Click on the Options menu and choose Simulation Controls.
The Simulation Controls dialog is displayed.

� Edit the Maximum Simulation Time, changing it from 5 to 10

seconds.

� Press OK to update the simulation controls.
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Now, we’re ready to execute the event.

� Use the viewer controls (thumb wheels, zoom slider and direct
hand-in-viewer manipulator) to set the view similar to that
shown in Figure 5-8.

Next, let’s set up the Key Results windows:

� If Key Results windows are not displayed, choose Show Key

Results from the Options menu.

� Drag the Key Results windows to a convenient location, where

they do not block the view but still allow us access to the

viewer thumb wheel controls (in case we want to change the

view).

Now, we’re ready to execute the event.

� Using the Event Controller, press Play to execute the event.

Watch as the vehicles approach each other, collide, and roll to their rest
positions.
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We have now completed the event.
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Time
(sec)

Percent Available Friction (%/100)

R/F L/F R/R L/R

2.70 0.00 0.00 0.00 0.00

2.80 0.20 0.20 0.01 0.01
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Viewing Results
Now that we have produced our EDSMAC simulations, let’s take a detailed
look at the results. The Playback Editor is used for reviewing and printing
reports for each event in the current case, as well as for producing video output.

EDSMAC produces the following reports:

� �������� ����	
� � A table of initial, impact, separation and final

positions and velocities for each vehicle

� 
����� 
��� � A table of damage profile coordinates, CDC, PDOF,

Delta-V and Peak Acceleration for each vehicle

� 
������
	����� - A 3-D visualization of the damage to each vehicle,

linked to the Playback Controller

� �������� - A list of messages produced by the current run

� �
	�
�� 
��� � A table containing program control information

� �
�����	
� ��������	� � A 3-D visualization of the event, displayed

at a user-selectable time interval

� ��
����������� �A table containing user-selectable, time-dependent

simulation results for each vehicle

� ������� 
��� - Tables containing all of the vehicle data and driver

control data used by the simulation

To view the output reports, we need to be in Playback mode:

� Choose Playback Mode. The Playback Editor is displayed.
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Report Windows

The reports listed on the previous page are displayed by selecting Report
Windows. Each Report Window contains an individual report.

To view the reports produced by the EDSMAC, Visibility Study event, perform
the following steps:

� Choose Playback Mode. The Playback Editor is displayed.

� Click Add New Object. The Report Window Information

dialog is displayed, as shown in Figure 5-9, and includes a list

of the active events (EDSMAC, Visibility Study is the only

event in this tutorial). The Report Window Information dialog

also includes the user-editable Report Window Name text field

and Selected Output option list.

� Select EDSMAC, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose any of the

available reports.

� Press OK to display the report.

The selected report will be displayed in a resizable window. The following
pages illustrate the reports produced for the EDSMAC, Visibility Study event.
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Accident History

The Accident History report displays the positions and velocities for each
vehicle at key times (Start of Run, Impact, Separation and Final/Rest) during
the run.

To view the Accident History report for the EDSMAC Visibility Study event,
perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Accident

History.

� Press OK.

The Accident History report is displayed for the EDSMAC, Visibility Study
event, as shown in Figure 5-10.
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Damage Data

The Damage Data report displays a table of collision vector results for each
vehicle. The collision vectors determine the total force on each vehicle. In
addition, the endpoints of the collision vectors define the damage profile.

The collision vectors are displayed both in cylindrical coordinates (RHO, PSI)
and Cartesian coordinates (x,y).

Following the table of collision vectors, the Damage Ranges are displayed.
The Damage Ranges report includes the beginning and ending point for each
damaged region on the exterior (up to 10 regions may be displayed for each
vehicle), followed by the CDC, PDOF, Delta-V and Peak Acceleration for
each damage region.
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To view the Damage Data report for the EDSMAC Visibility Study event,
perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Damage

Data.

� Press OK.

The Damage Data report is displayed for the EDSMAC, Visibility Study event,
as shown in Figure 5-11.
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Damage Profiles

The Damage Profiles report provides a visual representation of the damage to
each vehicle. This report is linked to the Playback Controller through the
Trajectory Simulation. Therefore, in order to see any damage in the Damage
Profiles report window, you must first open a Trajectory Simulation for the
event.

To view the Damage Profiles report produced by the EDSMAC, Visibility
Study event, perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Damage

Profiles.

� Press OK.

With a Trajectory Simulation also open, use the Playback Controller to view
the damage to each vehicle dynamically.

The Damage Profiles simulation for the Nissan Sentra in EDSMAC, Visibility
Study is shown in Figure 5-12.
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Messages

EDSMAC produces several messages, depending on the outcome of the run.
For a complete list and explanation of these messages, refer to Chapter 6.

To view the Messages report produced by the EDSMAC, Visibility Study event,
perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Messages.

� Press OK.

The Messages report for the Nissan Sentra in EDSMAC, Visibility Study is
shown in Figure 5-13.
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Program Data

The Program Data report displays the simulation controls (integration time
steps and termination conditions), collision parameters used by the EDSMAC
collision algorithm and the hard-coded values (RHOB Tests) used to
determine if a vector passes through the end (front or back) or side (left or
right).

To view the Program Data report for the EDSMAC, Visibility Study event,
perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Program

Data.

� Press OK.

The Program Data report is displayed for the EDSMAC, Visibility Study event,
as shown in Figure 5-14.
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Trajectory Simulation

The Trajectory Simulation report is a dynamic visualization, much like the
Event mode viewer, controlled by the Event Controller.
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To view the Trajectory Simulation for the EDSMAC, Visibility Study event,
perform the following steps:

� Click Add New Object. The Report Window Information
dialog is displayed.

� Select EDSMAC, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Trajectory
Simulation.

� Press OK.

The Trajectory Simulation viewer is displayed for the EDSMAC, Visibility
Study event. The vehicles are shown at their initial positions.

To visualize the motion, perform the following steps:

� Click Play (single right-arrow). The simulation begins and is
displayed at the current Playback output interval.

� Click Pause. The simulation stops.

� Click Reverse (single left-arrow). The simulation plays in
reverse.

� Click Pause. The simulation stops.

� Click Rewind (left arrow with bar). The simulation returns to
the start.

Click Advance to End (right arrow with bar) the simulation advances to the end
of the run.

The Trajectory Simulation for the Nissan Sentra in EDSMAC, Visibility Study
is shown in Figure 5-15.

� � ��

������ �	�&	
� '������



� � � 

�	�&	
� '������ �����	��

T
U

T
O

R
IA

L

������ ���� ,�
9������ !�)��
���� ��� &'!("�� ���������� !����� ���-�
���� ��� ��
��
��:����� 
� ��� ��� �� ��� �
����



Variable Output

The Variable Output table displays all the time-dependent results computed by
EDSMAC. To view the Variable Output report for the EDSMAC, Visibility
Study event, perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Variable

Output.

� Press OK.

The Variable Output report is displayed for the EDSMAC, Visibility Study
event. The next step is to select the time-dependent results we wish to display
in the table.

Variable Selection

The purpose of our EDSMAC study is to evaluate the avoidability of the
accident based on speeds and visibility. To document the path positions as a
function of time, let’s select the position, velocity and acceleration from the
Variable Selection dialog.

� Click on Select Variables in the Variable Output window. The

Variable Selection dialog is displayed, as shown in Figure 5-16

on the following page.

The Object Name option list displays the first vehicle, Ford Escort 2-Dr
Hatchback. The Kinematics output group is the default selection and the
Kinematics Variables list is displayed. Let’s add X, Y, Yaw, V����� and Accel
total to the Key Results window:

� Select X, Y, Yaw, V-tot and Acc-tot from the list .

Next, let add the same parameters for the Nissan Sentra:

� Click on the Object Name option list and choose Nissan Sentra

4-Dr. The Kinematics variable list is displayed.

� Select X, Y, Yaw, V-tot and Acc-tot from the list .
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� Press OK to add the selected variables to the Variable Output

window.
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The Variable Output report for the EDSMAC, Visibility Study event now
includes position, velocity and acceleration for both vehicles, plus any
other variables you may have added (see Figure 5-17).
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Vehicle Data

The Vehicle Data report displays the vehicle data, tire data and driver tables for
each vehicle in the event.
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To view the Vehicle Data report for the EDSMAC, Visibility Study event,
perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDSMAC, Visibility Study from the Active Events list.

� Click on the Select Output option list and choose Vehicle Data.

� Press OK.

A portion of the Vehicle Data report is displayed for EDSMAC, Visibility Study
in Figure 5-18.
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Printing

The final step is to print the above reports. Printing reports is simple. All you do
is choose a report and print it. For example:

� Click on the Variable Output - EDSMAC, Visibility Study

report window. The window is highlighted and pops to the top

of the display (if it isn’t there already), indicating it is the

current window.

� Click on the File menu and choose Print. The Print dialog is

displayed, allowing the user to select from several available

print options.
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� Press OK. The Variable Output report is printed on the system

printer.

That’s all there is to it! You can print any other report using the same three
steps described above.
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